StepStep-byby-Step Tutorials – Menus, Toolbars & Shortcuts

A Very
Very
Warm
Welcome
to the
Exciting
World of
Computers

Let’s get
Started
– It’s easy
with my StepStepbyby-Step
Instructions

StepStep-byby-Step Tutorials – Menus, Toolbars & Shortcuts

This lesson is all about getting to know your
Main Menu Bar at the top of your screen. Also
you will explore and try out some Keyboard
Shortcuts.

Let’s get started and have some fun while we learn.

How to Save Time and Effort with
Computer Shortcuts
The Menu Bar
Do This ….

1. First, open Microsoft Office Word. (Click on START, hold
mouse pointer over ALL PROGRAMS, hold mouse
pointer over MICROSOFT OFFICE, click on MICROSOFT
OFFICE WORD).
Have you ever noticed that in the menu bar at the top of the
screen some of the letters are underlined? For instance, the
letter "F" in the word File is underlined. If you look closely at a
few different programs, you will see that usually the first letter
is underlined, but sometimes a different letter is the chosen
one. You may see the "o" in Format underlined or the "a" in
Table.

Tutorials are being taught at several High Schools, Community Centers, Retirement Villages and Public Libraries
in Western Australia. They can now be downloaded from:

http://www.a-to-z-of-manners-and-etiquette.com/computer-tutorials.html
Course Originator and Author: Morna-Dawn Jacobs

© Morna-Dawn Jacobs. Course lessons may NOT be reproduced in any medium

2

StepStep-byby-Step Tutorials – Menus, Toolbars & Shortcuts

These keys are marked as shortcut keys.
Press and hold down the ALT key while you
press the indicated letter and you can access
your chosen menu without lifting your fingers
off the keyboard to use the mouse.
Go ahead and try it:
Do This ….

2. Hold down the ALT key and press F
3. Hold down the ALT key and press E
4. Hold down the ALT key and press V
5. Hold down the ALT key and press I
6. Hold down the ALT key and press O
7. Hold down the ALT key and press T
8. Hold down the ALT key and press A
9. Hold down the ALT key and press W
10.Hold down the ALT key and press H

That was easy …. Now try this:
After you have chosen and clicked on one of
the items from the menu bar, a drop-down
menu will appear with further choices.
(Try it by clicking on the word File in the upper left corner of
your screen, or use the shortcut explained above of Alt+F.)
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Again, some of the letters in the words will be underlined. You
can use any underlined letter to choose that option.
Go ahead and try it …..
Pressing the chosen letter is the same as clicking your mouse
on the chosen word.
However, you will also notice that some of the words in the
drop-down menu have another shortcut shown to the right of
the word. For instance, the word save has a CTRLS next to it. This means that you can use the CTRLS shortcut even if the menu is not shown. For
example, you press and hold down the CTRL key
and the "s" key simultaneously to save a file even
if you did not open the File drop-down menu first.
Do This ….

I know it is a lot to take in and remember

… try reading it all again, very slowly this time.

It is not

difficult, just difficult to remember everything! Why don’t you
write down just a few of the shortcuts that you would use the
most and practice them until they become second nature?
Another example, the word print has a CTRL-P next to it. This
means that you can use the CTRL-P shortcut even if the menu
is not shown. For example, you press and hold down the
CTRL key and the "p" key simultaneously to print a page even
if you did not open the File drop-down menu first.
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Do This ….

Go ahead and try it – but first, hit the Alt key
by itself to close the drop-down menu. Now,
press and hold down the CTRL key and hit the
‘P’ key while still holding down the CTRL key.
What happened?

Did the Print menu appear? Good.

We

don’t want to print anything right now, so just close that menu
by clicking on the X in the top right hand corner of that
window.
Keyboard shortcuts are very useful. As a matter of fact, they
can help to make your computing life much more pleasant.
They are available in most Windows programs, but finding
them can be a tiresome task. Many, but not all, Windows
programs share the same shortcuts.

The Basics
Let’s start with the most obvious ones, the shortcuts found
on the menu bar, as described above. You will find some of
these most useful:
•

DELETE removes the file, text, or graphic that you have
highlighted (clicked) and sends it to the recycle bin.

•

CTRL+S Saves the current file (note, you first have to
use the Save As menu to name your document).

•

CTRL+X Removes the current highlighted selection and
places it in an area of the computer memory.
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•

CTRL+C Copies the current highlighted selection. It
copies it from the document and places it in the
clipboard (this is a first step in copying something).

•

CTRL+V Pastes whatever is in the clipboard into the
document at the current location of the cursor (this is
the second and final step in copying something).

•

CTRL+A Selects or highlights all of the text and/or
objects in a document. This is handy when you want to
move or copy everything in the current document.

•

CTRL+P Prints the current document.

•

CTRL+O Opens a new document. This is especially
useful surfing the Web. In Netscape Navigator and newer
versions of Internet Explorer, this will bring up a window
where you can enter a Web address. (Older versions of
Internet Explorer use CTRL+L instead of
CTRL+O.
In addition to these shortcuts, each program
has other, less obvious shortcuts. You can
usually find these by going to the Help menu

and typing in the word "shortcut" or "keyboard shortcut".

Function Keys
Most computer keyboards have a row of function keys at the
top of the keyboard.
These keys are marked F1 through F12. While they were
widely used with older DOS programs, they are seldom used
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today. However many programs, including most of Microsoft's
popular products, support use of the function keys. As a
throwback to DOS days, you will find that the F1 key will often
bring up a help menu. The function keys are also often used
in combination with other keys like the CTRL key, the ALT
key, and the Shift key. This results in a plethora of possible
keyboard shortcuts. Look in the help menu of the program
that you are using to find a list of the function keys and their
uses.

Shortcuts to Help You Navigate
Ever want to move quickly to the beginning
or end of a document? Most programs will
take you there immediately when you use
Do This ….

CTRL+Home or CTRL+End.
Go ahead and try it (quickly type a few lines

of text first). Space down a few lines and type something
else.

Keep doing this until the page is full. Now try the

CTRL+Home or CTRL+End shortcut.
If you have several windows open at the same time, using
ALT+Tab will switch you to the window that you last used.
Holding down ALT while repeatedly pressing TAB will cycle
you through all of the open windows.
Do This ….

Give it a try …. If you don’t have any other windows open,
open one or two and then give the ALT+Tab shortcut a try.
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Shortcuts to Help You Find Things
If

you

have

a

Windows

keyboard,

pressing

Windows + F (the Windows key is on the bottom
left between Ctrl and Alt) will bring up the ‘find
window’ which is a help when you can't find a file.
If you don't have a Windows keyboard, F3 will bring up the
find window at the Windows desktop (the main Windows
screen).
If your Windows desktop is cluttered with icons and files, you
may have trouble finding the one that you are looking for. If
that's the case, simply press the first letter of the name of the
program or icon that you are looking for. For instance, if you
are looking for Internet Explorer, press the "I" key. If Internet
Explorer is the only icon on your desktop that starts with the
letter I, it will be highlighted. If there are other icons or
shortcuts that start with the letter I, pressing the I key again
will highlight each I icon in alphabetical order (you might need
to click on any icon first).

Power User Shortcuts
You can delete an item immediately without
placing it in the Recycle Bin by pressing Shift
+Delete. But be careful. Once you do this, there is
no way to retrieve the item.
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Now, this next one is a great shortcut:

When you are at the

Windows desktop, use Windows+E to pop up Windows
Explorer.
If you have been using My Computer to
view or move files, Windows Explorer is
like My Computer, but a bit more
powerful.

If

you

have

never

used

Explorer, try it. It's worth a look.
Right-click on My Computer and choose Properties to get to
the System Properties screen where you can find some of the
inner workings of the computer.
The two clicks mentioned above are worth noting because for
those of you who don't want to get that intimate with your
computer, this shortcut may still be useful since it takes you
to the screen which tells you which operating system you are
using, the type of processor in your computer, and the
amount of memory that your computer has.

Whatever you are doing, there are probably shortcut
keys to help you. Even if you love using
the mouse, there are times when you will
will
find shortcuts keys will save you time
and energy. Just think if you discovered
only one shortcut a month and learned to use it, by the
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end of the year not only would you be more productive,
but you might also like your computer more.
Now have a look at the menus and toolbars, don’t be
afraid to try them out.

THE MAIN MENU BAR
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The FILE Drop Down Menu
FILE
New

Ctrl+N

Open

Ctrl+O

Close
Save

Ctrl+S

Save As
Save as Web Page
File Search
Permission

>

Versions

Unrestricted Access
Do not Distribute
Restrict Permission As

Web Page Preview

Page Setup
Print Preview
Print

Ctrl+P

Send To
Properties

>

Mail Recipient
Mail Recipient (for review)
Mail Recipient (as attachment)
Routing Recipient
Exchange Folder
Online Meeting Recipient
Recipient using a Fax Modem
Recipient using an Internet
Fax Modem
Microsoft Power Point
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The EDIT Drop Down Menu
EDIT
Undo

Ctrl+z

Repeat

Ctrl+y

Copy

Ctrl+c

Cut

Ctrl+x

Office Clipboard
Paste

Ctrl+v

Paste Special
Paste Hyperlink
Clear

>

Formats
Contents

Del

Select All Ctrl+a
Find

Ctrl+f

Replace

Ctrl+h

Go To

Ctrl+g

Links
Object
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The VIEW Drop Down Menu
VIEW
Normal
Web Layout
Print Layout
Reading Layout
Outline
Task Pane
Toolbars
Ruler
Document Map
Thumbnails
Header Footer
Footnotes
Markup
Full Screen

>

Standard
Formatting
Auto Text
Control Toolbox
Data Base
Drawing
Email
Forms
Frames
Mail Merge
Outlining
Picture
Reviewing
Tables & Borders
Text Box
Visual Basic
Web
Web Tools
Word Count
Word Art
Customize

Drawing Toolbar
[usually appears at the bottom of your screen]

Showing the different icons.

Zoom

Formatting Toolbar
[usually appears at the top of your screen].
Showing the different icons – run your mouse pointer over the
icons to see what they do
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The INSERT Drop Down Menu
INSERT
Break
Page Numbers
Dates & Time
Auto Text

>

Field
Symbol

Auto Text
New
Alt+F
Attention to line
Closing
Header & Footer
Mail Instruction
Reference Initials
Reference Line
Salutation
Signature
Subject Line

Comment
Reference

>

Web Component
Picture
Diagram
Text Box
File

Foot Notes
Caption
Cross
Reference
Index & Tables

>

Clip Art
From File
From Scanner or
Camera
New Drawing
Auto Shapes
Word Art
Organization chart
Chart

Object
Bookmark
Hyperlink
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The FORMAT Drop Down Menu
FORMAT
Font
Paragraph
Bullets & Numbering

Borders & Shading
Columns
Tabs
Drop Cap
Text Direction
Change Case
Background

>

Colour Pallet

Theme
Frames

>

Auto Format

Table of Contents
in Frame
New Frames Page

Styles & Formatting
Reveal Formatting
Format & Auto
shape/Picture
Textbox
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The TOOLS Drop Down Menu
TOOLS
Spelling & Grammar F7
Research

Alt + Click

Language

>

Set Language
Translate
Thesaurus Shift + F7
Hyphenation

Word Count
Auto Summarize
Speech
Shared Workspace
Track Changes
Compare & Merge
Documents
Protect Document
Online Collaboration

>

Letters & Mailings

>

Macro

Meet Now
Schedule Meeting
Web Discussions

>

Templates & Add Ins
Auto Correct Options

Macros
Alt+F8
Record New Macro
Security
Visual Basic Editor Alt+F11
Microsoft Script Editor
Alt+Shift+F11

Mail Merge
Show Mail Merge Toolbar
Envelopes and Letters
Letter Wizard

Customize
Options
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The TABLE Drop Down Menu
TABLE

Table
Columns to the left
Columns to the right
Rows above
Rows below
Cells

Draw Table
Insert

>

Delete

>

Select

Table
Columns
Rows
Cells

>
Table
Columns
Rows
Cell

Merge Cells
Split Cells
Split Table
Table Auto Format
Auto Fit

>

Auto Fit to Contents
Auto Fit to Window
Fixed Column Width
Distribute Rows Evenly
Distribute Columns Evenly

Heading Rows Repeat
Convert

>

Text to Table
Table to Text

Sort
Formula
Hide Grid Lines
Table Properties
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The WINDOW Drop Down Menu
WINDOW
New Window
Arrange All
Compare Side by Side With

Split

The HELP Drop Down Menu
HELP
Microsoft Office Word Help
Show Office Assistant
Microsoft Office Online

Contact Us
Word Perfect Help
Check for Updates
Detect & Repair
Activate Product

Hope you enjoyed the lesson ….
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